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    Prefácio

    
        
        
            O professor Everton Coimbra de Araújo já escreveu diversos livros na área de informática, que são utilizados em diversas universidades como referência nas disciplinas. Eu mesmo já utilizei alguns como guia para ministrar minhas aulas na UTFPR campus Medianeira, e sempre tive bons resultados.

O diferencial dos livros do Everton é que ele tem conhecimento didático sobre os assuntos que escreve e sempre faz referência ao dia a dia nas empresas, o que torna a obra muito mais interessante.

O assunto abordado neste livro é realmente o que profissionais da área de desenvolvimento estavam precisando para desenvolver seus aplicativos para dispositivos móveis.

Há pouco tempo, quando se decidia desenvolver aplicativos, deveria se optar para o sistema operacional Android ou iOS, sendo despendido muito esforço para adaptar para os dois sistemas operacionais. Com o framework apresentado neste livro, o Ionic, o desenvolvedor deverá despender esforços apenas na sua aplicação, sendo transparente a questão do sistema operacional. 

Lendo este livro me resta pouca saudade do desenvolvimento de aplicativos para Palmtop, PDAs ou HandHelds. Como ficou fácil desenvolver aplicativos para os usuários trabalharem remotamente sem necessidade de conexão através dos modens ou levar o equipamento até a empresa para transferência dos dados.

O autor foi muito feliz na forma como escreveu este livro. Nos capítulos iniciais, faz uma contextualização de dispositivos móveis e ferramentas utilizadas, de forma que o leitor não precisa ser um expert. Em seguida, é apresentada a instalação e teste da plataforma que será utilizada. Ele vai explicando o assunto e ligando a leitura aos conteúdos dos capítulos seguintes de uma forma fácil, didática e interessante de aprendizado.

No final da leitura deste livro você estará apto para desenvolver bons aplicativos comerciais, utilizando uma das melhores ferramentas disponíveis no mercado para dispositivos móveis. Uma boa leitura.



César Angonese

Universidade Tecnológica Federal do Paraná - Campus Medianeira


        
        

    



        
        
    
    


        
        

    Sobre o livro

    
        
        
            Este livro traz, na prática, o desenvolvimento de aplicações cross-platform com o Ionic, um framework para desenvolvimento de aplicativos para dispositivos móveis e web. Desenvolver um aplicativo para ser publicado em dispositivos com plataformas diferentes (iOS e Android) é uma tarefa tranquila com o Ionic. É possível criar uma aplicação utilizando a linguagem HTML e TypeScript, e ela ser publicada para as duas plataformas, além do navegador.

O livro é desenvolvido em dez capítulos. O primeiro é apenas teórico, mas não menos importante, pois trago nele contextualizações sobre dispositivos móveis e as ferramentas usadas no livro. Já no segundo, apresento o processo de instalação e teste da plataforma e do IDE que utilizaremos, o Visual Studio Code. Embora o Ionic traga recursos para publicação de aplicações em plataformas diferentes que o iOS e Android, o foco no livro será para estas duas.

A aplicação a ser implementada durante o livro refere-se a uma oficina mecânica, com cadastro de clientes, serviços, peças e atendimentos. Persistiremos os dados localmente, no navegador, em uma execução da aplicação em ambiente web. Depois em uma base de dados local e, ao final, faremos uso de recursos do Firebase. Ofereceremos ao usuário a possibilidade de capturar fotos no momento do cadastro do cliente.

A prática começa bem legal no capítulo 3, onde criaremos interfaces com o usuário para interação com a aplicação. Veremos alguns recursos possíveis para tratamento dos dados informados, validando e informando ao usuário possíveis inconsistências. Veremos nossos primeiros controles visuais e buscaremos entender a estrutura de aplicações Ionic.

No quarto capítulo, trabalharemos a navegação entre páginas, criaremos uma página para listagem de dados e a partir desta página possibilitaremos a navegação para outra. Também teremos a introdução em serviços na concepção de componentes do Ionic. Teremos neste capítulo um CRUD completo, onde poderemos inserir, recuperar, atualizar ou remover dados.

No capítulo 5, trabalharemos a persistência física de dados, iniciando com o Storage do Ionic, que mantém os dados no navegador, onde teremos nossos primeiros exemplos. Após esse conhecimento, faremos uso de um banco de dados, o SQLite, também para a persistência física dos dados. Para os dois cenários teremos as operações CRUD implementadas.

No capítulo 6, traremos o conceito de Sidemenu do Ionic, que é uma página que serve como um menu de opções disponibilizadas pela aplicação para o usuário. Começaremos aqui o trabalho de associação de classes de negócio em nossas páginas de interação com o usuário.

Dando sequência ao tema de persistência, no capítulo 7, conheceremos o Firebase e vamos utilizar o Firestore, que é uma solução do Google para persistência e sincronização de dados em aplicações web e para dispositivos móveis. Um capítulo muito legal.

No capítulo 8, vamos interagir com a câmera e álbum de fotos de nossos dispositivos físicos. Possibilitaremos ao usuário capturar uma foto de um cliente ou selecioná-la de seu álbum de fotografias. Inicialmente gravaremos esta imagem em nosso dispositivo. Depois, no mesmo capítulo, faremos uso de outra ferramenta da Google, o Storage, que é capaz de armazenar imagens na nuvem. Veremos as operações CRUD também para essas imagens e as associaremos com nossos clientes.

Já nos aproximando do final do livro, veremos uma nova maneira de navegação entre páginas oferecidas pelo Ionic, as guias (Tabs). Para ilustrar seu uso, trabalharemos com autenticação do usuário e, uma vez mais, recorrendo ao Firebase, utilizaremos a ferramenta Authentication e você verá que é muito simples e flexível.

Enfim, como último capítulo, o de número 10 traz a integração com o Google Maps. Pesquisaremos endereços e buscaremos nossa localização. Fechando o capítulo e o livro, veremos como alterar a imagem de inicialização de nossa aplicação e o ícone que ela terá em nosso dispositivo.

Certamente, este livro pode ser usado como ferramenta em disciplinas que trabalham o desenvolvimento de dispositivos móveis, quer seja por acadêmicos ou professores. Isso porque ele é o resultado da experiência que tenho em ministrar aulas dessa disciplina, então trago para cá os anseios e as dúvidas dos alunos que estudam comigo. Eu já utilizo este conteúdo com meus alunos e eles gostam muito.

É importante que você tenha conhecimento de Orientação a Objetos e de alguma linguagem de programação, mas não é um fator impeditivo. Conhecimentos básicos sobre banco de dados também são interessantes. O repositório com todos os códigos-fontes usados no livro pode ser encontrado em: https://github.com/evertonfoz/implementacoes-de-livros/tree/master/ionic.

Os arquivos disponibilizados no GitHub estão de acordo com as versões apontadas no livro. Recomendo que, inicialmente, você implemente os exemplos nestas versões e, após o sucesso, tente atualizar para a mais recente, já que é possível que haja essa atualização quando você estiver lendo este livro, uma vez que a equipe do Ionic é muito dinâmica e sempre está disponibilizando atualizações evolutivas e corretivas. Reforçando, fique atento ao caso de atualizar os plugins e componentes dos projetos, pois essa tecnologia é dinâmica e atualizações estão sempre ocorrendo.

Que a leitura deste livro seja para você tão prazerosa como para mim foi escrevê-lo. Desfrute, sem moderação. Sucesso.


        
        

    



        
        
    
    


        
        

    Capítulo 1

Dispositivos móveis, desenvolvimento cross-platform e Ionic

    
        
        
            Olá! Seja bem-vindo ao primeiro capítulo deste livro. Ele será curto e conterá apenas teoria, mas nos demais compensarei com a prática. Nele, buscarei trazer conteúdo sobre o panorama dos dispositivos móveis, tipos de dispositivos, suas características e opções para o desenvolvimento de aplicativos.

As ferramentas que serão usadas neste livro serão apresentadas conforme forem necessárias. É importante que você tenha conhecimento do paradigma de Orientação a Objetos e de alguma linguagem de programação Orientada a Objetos para um perfeito acompanhamento do desenvolvimento proposto para este livro. O desejável é um conhecimento ainda que básico em tecnologias WEB, como HTML, CSS e JavaScript, entretanto este não é um requisito proibitivo para você ler este livro.

A aplicação proposta para ser desenvolvida neste livro, a partir do terceiro capítulo, refere-se ao atendimento oferecido por uma oficina mecânica. A aplicação subsidiará o cadastro de clientes, peças e serviços a serem contratados para veículos e registro de atendimento a clientes. Nessas funcionalidades, serão trabalhados tipos de telas para a aplicação, controles de entrada de dados, listagem de dados, templates para aparência da aplicação, acesso a banco de dados, consumo de serviços web e uso de câmera.

Não faz parte do escopo do livro ter essa aplicação implementada em sua totalidade, mas sim para a aplicação do Ionic em algumas funcionalidades relacionadas a este problema proposto.

Durante o desenvolvimento da aplicação, diversas técnicas e recursos serão utilizados para subsidiar uma boa arquitetura para o desenvolvimento da aplicação.

1.1 Os dispositivos móveis na atualidade

Antes de começarmos esta seção, permita-me um alerta. A contextualização proposta aqui é semelhante à que utilizei em demais livros sobre dispositivos móveis aqui da Casa do Código. Optei por isso por estar trabalhando uma mesma situação. Dessa maneira, nesta e na próxima seção, você pode ter um sentimento de déjà-vu, mas é só nelas, ok? Depois, tudo é com base no Ionic.

Até anos atrás, era comum conhecer pessoas que adquiriam computadores apenas para navegar na internet, ler e-mails e acessar algumas aplicações para leitura de livros, artigos ou documentos diversos. No lado corporativo empresarial, notebooks eram fornecidos aos colaboradores para que desempenhassem algumas atividades, como registro de uma venda para um cliente, recebimento de uma conta, anotação de um pedido e agendamento de compromissos, dentre diversas outras atividades.

Com o surgimento dos dispositivos móveis, a venda de computadores pessoais tem sofrido constantes quedas. Isso começou lá atrás, de maneira modesta e quase despercebida, com handhelds, palmtops e PDAs (Personal Digital Assistants), mas que começou a ganhar destaque com a chegada do iPod e, depois, dos iPhones. A massificação veio por meio do Google, com o desenvolvimento do sistema operacional Android para dispositivos mais ace$$ívei$, em relação aos produtos da Apple.

Embora um dispositivo móvel permita atendermos a necessidades pessoais e corporativas, é importante ressaltar que a maneira como este mercado se desenvolveu foi bem distinta. Tem-se o lado recreativo, em que é possível ter em seu dispositivo diversos jogos; o cultural, que permite o acesso a filmes e livros; o da organização pessoal, com diversos recursos para gestão financeira e de compromissos, acesso a bancos, compras; e a parte empresarial, com aplicativos corporativos, de gestão, operacional das empresas e vendas. Há ainda pessoas que utilizam esse dispositivo apenas para navegar na internet e acessar redes sociais, dispensando, em muitos casos, a necessidade de um computador.

Toda essa popularização e mudança comportamental resultaram no que é visto atualmente como um fenômeno BYOD (Bring Your Own Device — Traga seu Próprio Dispositivo). Ou seja, o colaborador está levando para seu ambiente de trabalho um dispositivo potente (o seu) e que pode, em alguns casos, ser substituído por um computador. 

Com isso e com o acesso à rede corporativa liberado, todos podem ter no bolso as aplicações de seu local de trabalho. Isso pode gerar mais produtividade também (ou não :-)). Porém, no que diz respeito à segurança, traz novas ameaças e vulnerabilidades, mas isso é assunto para a equipe de infraestrutura.

Pense em trabalhos que exigem atividade externa, quer seja em campo ou locais urbanos, como a função de um engenheiro agrônomo ou um vendedor externo. Esses profissionais precisavam se dirigir à empresa, buscar blocos ou formulários impressos específicos para coleta de dados, retornar aos seus escritórios e registrar os dados coletados. Com um dispositivo móvel, ele não precisa nem ir ao seu escritório, pois seu equipamento já permite o registro de sua coleta ou venda no momento em que ela ocorre. Você também já reparou onde os atendentes de restaurantes registram nossos pedidos? Em um dispositivo móvel.

E se o acesso à internet não for possível no momento da atividade, é possível uma sincronização com os servidores da empresa tão logo uma conexão seja possível. Os dispositivos também podem estar conectados apenas a uma rede interna, não sendo necessária a internet.

As empresas buscam também tirar proveito dessa realidade, quer seja dando maior liberdade para seus colaboradores, ou economizando em despesas, como energia, água, condomínio ou aluguel, dentre outras.

Neste livro, trabalharemos aplicações que possam ser executadas, com recursos nativos, nos sistemas operacionais iOS e Android. Neste último, existem diversos dispositivos, nas mais diversas especificações de tamanho e resolução de tela, recursos e processamento.

1.2 O desenvolvimento móvel cross-platform

Não é porque os dispositivos móveis estão em uma grande ascendência que os computadores pessoais se tornaram descartáveis. Existem ainda diversas atividades e aplicativos que precisam ser realizados e utilizados em um computador que possua um teclado (que não seja na tela), uma tela grande (às vezes mais do que uma) e um desempenho ainda não alcançado pelos dispositivos móveis atuais. 

Com isso posto, é importante estar ciente de que as aplicações comerciais trazidas para o ambiente móvel precisam, nas interações com o usuário, ter ou solicitar dados e informações que possam caber "confortavelmente" na tela que será usada. Nada de encher de informações desnecessárias para o processo atual.

O desenvolvimento para dispositivos móveis, até a presente data, vem sendo focado nas plataformas iOS e Android, que são as mais utilizadas. Cada uma dessas plataformas possui suas próprias características e recursos. Com isso, você pensa em escolher uma plataforma para que seu aplicativo funcione e limitar o uso a apenas esta? 

Se for uma empresa que especifique a plataforma e se o aplicativo deve funcionar apenas entre os colaboradores dela, isso é uma opção sim. Mas e se sua aplicação precisar ser utilizada em plataformas diferentes? Aí esta opção já não poderia ser escolhida.

O que vem ocorrendo no desenvolvimento para dispositivos móveis é que, ao desenvolver uma aplicação para um dispositivo e uma plataforma, esperamos que esta aplicação possa funcionar em qualquer dispositivo, de qualquer plataforma. 

Por exemplo, deseja-se que uma aplicação desenvolvida para o iPhone 12 Pro Max possa funcionar da mesma maneira em um smartphone com Android. O que fazer para resolver este problema? Montar várias equipes de desenvolvimento, cada uma usando um ambiente de desenvolvimento diferente e focada em uma plataforma? Desenvolver diversas versões do mesmo aplicativo? Isso não é produtivo e nem barato, concorda?

O objetivo é partir para uma ferramenta que possibilite o desenvolvimento cross-platform. Existem várias. Algumas geram o aplicativo para ser executado em um ambiente específico, como se fosse uma máquina virtual (conhecido como ambiente híbrido). Outras ferramentas geram código para ser executado em um ambiente web, como se fosse um site em um navegador (que é o caso do Ionic) e, temos ainda, ferramentas que geram aplicativos nativos para as plataformas escolhidas, como o Xamarin e o Flutter. O Ionic, por meio de frameworks específicos, como Cordova e Capacitor, possibilitam a transformação de uma aplicação Ionic em uma aplicação híbrida. Veremos isso a partir do próximo capítulo. 

O site do Ionic oferece um livro gratuito chamado Hybrid Vs. Native, que, durante a escrita deste livro, está sendo disponibilizado na página principal do Ionic, a https://ionicframework.com/. Quando tiver tempo, talvez seja interessante lê-lo. É bem pequeno.

Um ponto importante é verificar na App Store (iOS) e no Google Play os padrões e as regras que devem ser respeitados para a publicação oficial de sua aplicação. Por exemplo, os ícones das aplicações são diferentes em cada plataforma, assim como a barra de navegação e o padrão de cores. São alguns dos pontos que você deve verificar e garantir que sua aplicação os respeite para que a publicação seja aceita. E para você distribuir aplicações pela App Store e Play Store, será necessário ter uma conta de desenvolvedor, que é paga.

1.3 O Ionic Framework

De acordo com o próprio portal do Ionic, ele é definido como um framework, de código aberto, de ferramentas para serem utilizadas para o desenvolvimento da interface com o usuário, que permite um bom desenvolvimento de aplicações baseadas em tecnologias para web, como JavaScript, HTML e CSS. Outra definição, do próprio portal, traz o Ionic como uma biblioteca de componentes de interface com o usuário (UI).

Embora o Ionic seja open source e permita o desenvolvimento de aplicações com ferramentas gratuitas, ele possui pacotes com recursos adicionais pagos - e que talvez você julgue interessante. Quando puder, verifique em     https://ionic.io/pricing.

Como dito no primeiro parágrafo desta seção, o Ionic tem como foco o desenvolvimento de aplicações baseadas em tecnologia para web, que executam em um navegador, ou ainda em dispositivos de plataforma específica. Desta maneira, o desenvolvimento cross-platform, por meio do Ionic, faz uso do modelo híbrido de aplicações móveis. Ou seja, ele permite que aplicações desenvolvidas em Ionic sejam executadas em dispositivos móveis, mas não fazendo uso direto de recursos nativos, embora, como veremos, isso seja possível por meio de componentes de terceiros. As aplicações Ionic são conhecidas como Webview, ou ainda, Frontend Application.

Como uma plataforma para desenvolvimento de aplicativos cross-platform, o Ionic tem como foco dispositivos móveis com o iOS e Android e, quando executarmos nossa primeira aplicação, os veremos em seus respectivos pseudoemuladores, gerados pelas ferramentas do Ionic. 

A linguagem de programação que adotaremos, e a padrão para o desenvolvimento em Ionic, é a TypeScript, que possibilita um desenvolvimento estático, com compilação em tempo de implementação, garantindo que o código JavaScript que será gerado esteja livre de erros sintáticos. Também utilizaremos o HTML e CSS em nossas camadas de apresentação, e você verá que estes recursos abrem um enorme leque de customização da interface com o usuário. Estes conhecimentos não são excludentes para quem deseja ler este livro, pois fornecerei explicações que sejam suficientes para o acompanhamento das atividades, buscando sempre deixar referências que possam complementar seu conhecimento. 

O TypeScript, de acordo com seu próprio portal, é um superconjunto tipado que é compilado para JavaScript puro. Todo código TypeScript que implementarmos, após uma compilação bem-sucedida, será gerado para código JavaScript, que é o código que será utilizado pela aplicação no dispositivo. Embora a linguagem foco seja TypeScript, teremos implementações em JavaScript puro também, o que é perfeitamente válido para código TypeScript.

O TypeScript foi desenvolvido como uma iniciativa da Microsoft, por Anders Hejlsberg, criador do Turbo Pascal, Delphi e C#. Vem sendo uma linguagem/ferramenta adotada de forma cada vez maior pela comunidade de desenvolvedores JavaScript. Ela permite inclusive o desenvolvimento Orientado a Objetos, fazendo uso de classes, interfaces, herança e métodos, dentre outras características deste paradigma. Conforme formos utilizando esses recursos durante nossas aplicações, procurarei contextualizá-los.

De acordo com relatos identificados na web, o Ionic sofreu mudanças drásticas na passagem da versão 1 para a 2 e, consequentemente, para a 3 e 4. Da 4 para a 5 e 5 para 6, algumas mudanças também ocorreram, mas acredito que seja para uma maturidade necessária. Essas atitudes causou e ainda causam uma série de desconfortos na comunidade desenvolvedora, pois gerou e gera muita mão de obra para atualização de suas aplicações, havendo casos até de pessoas que optaram por mudar de plataforma. A versão 4 começou o processo de trazer para o Ionic arquiteturas já validadas pela comunidade, como Angular, Vue e React, já disponíveis a partir da versão 5. Nós utilizaremos o Angular neste livro. No próximo capítulo, comentarei ele de maneira mais descritiva.





Conclusão

Conforme prometido no início deste capítulo, ele foi breve. Eu poderia trazer muito mais teoria aqui, mas penso que você quer começar logo com a prática. Entretanto, precisava lhe apresentar o texto aqui trabalhado. 

É importante ler um pouco sobre dispositivos móveis, cross-platform, TypeScript, JavaScript, HTML e CSS. É claro que o que eu trouxe para você foi apenas uma introdução, mas acredite, com ela você já está pronto (a) para começar o desenvolvimento móvel e você tem motivos para escolher o Ionic. Isso porque você quer e precisa desenvolver para, no mínimo, duas plataformas e posso assumir que não quer, ou não pode, ter uma equipe para cada plataforma. 

Se você precisa de produtividade e quer que sua aplicação seja desenvolvida em uma única plataforma, mas que seja executada nas duas mais usadas atualmente, então a solução que proponho neste livro é o Ionic. 

No próximo capítulo, instalaremos a ferramenta e testaremos seu funcionamento. Até lá.


        
        

    



        
        
    
    


        
        

    Capítulo 2

Ionic — Instalação e testes

    
        
        
            O processo de preparação do ambiente de trabalho para desenvolvimento e distribuição de aplicações Ionic em dispositivos móveis exige a instalação de algumas ferramentas que são pré-requisitos. Neste segundo capítulo, veremos essas ferramentas e algumas possibilidades para execução e testes de aplicações. Também instalaremos o ambiente para a codificação de nossas práticas, o IDE, que será o Visual Studio Code. 

Com as ferramentas e dependências instaladas, trabalharemos a criação e execução de uma aplicação simples para validar a corretude desse processo. Trabalharemos a distribuição da aplicação em dispositivos físicos e emuladores, por meio de frameworks que realizam esta ligação de código front-end com os SDKs nativos de cada plataforma. Veremos o uso do Capacitor, embora ainda seja possível fazer uso do Cordova. Temos aqui um capítulo relativamente simples, mas que envolve um certo esforço e atenção em todo o processo.





2.1 Ferramentas, downloads e instalação

Estou usando dois equipamentos para desenvolvimento. Um i7, com 32GB de RAM e Windows 10 com todos os updates realizados e um MacBook Air, M1, com 8GB de RAM, executando o macOS Monterey, devidamente atualizado. Todas as ferramentas utilizadas nestes equipamentos podem também ser instaladas em plataforma Linux, seguindo sempre as orientações específicas para ela, que são sempre fornecidas nos portais dessas ferramentas.

Como dito no início do capítulo, para instalarmos e termos o Ionic disponível para nosso desenvolvimento, precisamos antes realizar o download de algumas dependências. A primeira delas será o Git, que é um sistema de controle de versões distribuído. O Git é muito usado entre desenvolvedores, podendo versionar qualquer tipo de documento. Em conjunto com o Git, é muito comum a associação com o GitHub, portal que hospeda um imenso número de projetos, componentes, aplicações e documentos.

É possível obter o Git para download em https://git-scm.com/downloads/ e, no momento da escrita deste livro, a versão disponível é a 2.34.1. Realize o download e a instalação deste nosso primeiro pré-requisito. Caso não queira se preocupar, basta seguir as sugestões do padrão de instalação. Se quiser se aprofundar em cada opção, recomendo uma leitura no portal da ferramenta. Caso não conheça o Git e o GitHub, recomendo os vídeos do meu canal disponíveis em https://www.youtube.com/watch?v=-KcIGuwkoaA&t=3s.

Necessitamos também do Java (JDK) instalado em nossa máquina, pois, no desenvolvimento para Android, o Java é um pré-requisito. A partir da versão 5 do Ionic, a utilização do Capacitor é a recomendada, ao contrário das anteriores, que priorizavam o uso do Cordova. A versão do Capacitor que utilizaremos é a 3.3.3. Recomendo que você possa fazer um tour em https://capacitorjs.com/, para ver os processos de instalação, migração do Cordova, plugins disponíveis, mas isso pode ser feito no seu tempo.

Em relação ao Java, é preciso a versão 1.8.X do JDK, que você pode baixar em https://www.oracle.com/technetwork/pt/java/javase/downloads/jdk8-downloads-2133151.html. Será preciso que você coloque o caminho no PATH de sua máquina, incluindo a pasta bin, e você pode ver orientações para isso aqui: https://www.java.com/pt_BR/download/help/path.xml. Embora o Java esteja em versões mais atualizadas, reforçando, é a 1.8.X que deve estar em sua máquina.

Para trabalharmos com a plataforma Android, por meio de dispositivos ou emuladores, eu particularmente recomendo a instalação do Android Studio, pois ele faz todas as configurações necessárias para o nosso desenvolvimento. É possível instalar apenas os recursos necessários caso você queira, mas por complexidades que tive em relação a isso, buscando uma solução mais simples e efetiva, adotei a instalação desta ferramenta, que pode ser obtida em https://developer.android.com/studio. No momento da escrita deste livro, ela está na versão Artic Fox | 2020.3.1. 

Com o término da instalação, execute o Android Studio e na janela que se abre, selecione o botão More Actions e nele a opção SDK Manager, tal qual mostra a figura a seguir. 




[image: Acessando o gerenciador do Android SDK. ]Figura 2.1: Acessando o gerenciador do Android SDK.



Na nova janela que se abre, serão exibidas as plataformas disponíveis para instalação. Eu recomendo que você instale pelo menos as três últimas versões, em meu caso foram as APIs 31, 30 e 29. 

Após a seleção, confirme a instalação clicando no botão Apply. Esse processo pode demorar um pouco, pois ele depende de conexão com a internet. Observe e guarde o endereço que aparece no topo desta janela, que é onde o SDK foi instalado, porque precisaremos dele. 

Precisamos agora baixar e instalar em nossa máquina o(s) emulador(res) onde executaremos nossa aplicação Android, mas, sempre que puder, faça uso de dispositivos físicos para o desenvolvimento, é bem mais rápido. Como baixamos o Android Studio, vamos fazer uso dele para este processo de instalação de emuladores. Da mesma maneira que acessamos o SDK Manager anteriormente, vamos acessar o AVD Manager para essa atividade. Ao acessar essa ferramenta você terá acesso a uma janela como a apresentada na figura a seguir.




[image: Acessando o gerenciador de dispositivos virtuais do Android. ]Figura 2.2: Acessando o gerenciador de dispositivos virtuais do Android.



Nesta janela, existe uma relação de dispositivos previamente configurados, que podem ser baixados para nossas máquinas. Pode ser que nenhum dispositivo seja apresentado em seu AVD Manager, o que nos remete a criá-lo. Para isso, clique no botão Create Virtual Device. Na janela que se abre, precisamos escolher o modelo do dispositivo que utilizaremos. Eu selecionei o Nexus 6P dentro da categoria Phone e então cliquei no botão Next. A nova janela traz três guias. Na primeira, precisamos instalar a API para a imagem do dispositivo que estamos criando. Eu selecionei a 30 neste exemplo e realizei o download dela. Ao término do download, precisamos ir para a segunda guia, responsável pela imagem em si do dispositivo. Optei pela x86_64 da API 30 e fiz o download dela. Após a conclusão, retornei para a primeira guia e cliquei no botão Next, o que levou para a última janela, para definição do nome do emulador. Informe o que desejar, confirme a operação e você retornará para o AVD Manager, podendo executar o emulador.

Com a configuração dos emuladores concluída, precisamos criar uma variável de ambiente, chamada ANDROID_SDK_ROOT, apontando para o SDK do Android, que em minha máquina é C:\Users\Everton\AppData\Local\Android\Sdk. Este é o endereço que comentei há pouco para você guardar. Uma vez mais, é possível verificar como criar uma variável de ambiente em https://www.java.com/pt_BR/download/help/path.xml.

Começaremos agora a instalação de ferramentas que usaremos diretamente em nosso desenvolvimento. Começaremos com o NodeJS. De maneira simples e rápida, podemos dizer que o Node.js é um aplicativo interpretador de código JavaScript, executando no lado servidor da aplicação e não (apenas) no lado cliente, como é comumente utilizado. Segundo o próprio portal do Node.js (https://nodejs.org), a ferramenta tem também o objetivo de auxiliar programadores na criação de aplicações escalonáveis, com enorme capacidade de processamento. Durante a leitura deste livro, faremos uso do Node nos momentos em que instalaremos plugins e componentes que nos auxiliem no desenvolvimento, além do próprio Ionic. Também teremos o Node em execução quando formos testar as aplicações que desenvolveremos em Ionic. A versão disponível no momento da escrita deste livro é a 17.2.0, porém, as versões ímpares não são recomendas para produção e quando usei esta versão realmente tive problemas, que exigiram muito esforço para tudo funcionar. Desta maneira, recomendo o uso da versão 16.13.1 LTS. A dica é usar sempre uma versão PAR e que tenha o LTS em seu nome.

Você pode verificar se já tem o Node instalado em seu ambiente, bastando, no console (Command, Windows PowerShell ou Terminal, acessando sempre como Adminstrador) digitar node -v e npm -v. Caso as ferramentas já estejam disponíveis em sua máquina, verifique as informações retornadas e veja se seu ambiente está atualizado. Caso precise atualizar, recomendo baixar novamente o instalador e executá-lo, é mais simples. Entretanto, existe na documentação processos apenas para a atualização, mas deixarei isso para você.

Em relação ao NPM (Node Package Manager - Gerenciador de Pacotes do Node), ferramenta que utilizaremos muito, o portal NodeBR (http://nodebr.com/) traz a informação de que ele pode ser visto de duas maneiras: segundo o portal, a primeira e a mais importante é que o NPM é um repositório on-line para a publicação de projetos de código aberto para o Node.js; em sua segunda visão, mais técnica, é um aplicativo de linha de comando que interage com esse repositório on-line, auxiliando na instalação de pacotes, gerenciamento de versão e gerenciamento de dependências em nossas aplicações. Quando instalamos o Node.js, o NPM é também instalado por padrão.

Retornando ao Ionic, podemos afirmar que as aplicações desenvolvidas por ele são criadas e assistidas por um utilitário de linha de comando, conhecido como Ionic CLI, ou Ionic Command Line Interface. O Ionic CLI é a ferramenta que o framework oferece para execução de diversas atividades durante o processo de desenvolvimento, como a criação do projeto da aplicação, criação automatizada de artefatos para seus projetos e execução das aplicações, dentre outras funcionalidades que veremos no desenvolver do livro.

Para instalarmos o Ionic e termos à nossa disposição o Ionic CLI, precisaremos fazê-lo por meio do NPM, que já instalamos em passos anteriores, junto com o Node.js. Para iniciarmos, é preciso acessar a console do Windows (Command) ou o Windows PowerShell, com direitos de administrador. Já no Mac é preciso acessar como sudo. Veja o conjunto de instruções a seguir, cada uma precedido de comentários.

// Instalação da versão mais atualizada do Ionic/CLI de maneira global no sistema (-g)
npm install -g @ionic/cli

// ou

// Instalação de uma versão específica para o Ionic/CLI, no caso, a 6.18.1, que será a que utilizaremos em todo o livro
npm install -g @ionic/cli@6.18.1


Fique atento ao retorno deste processo. É comum haver avisos para a atualização do NPM, mesmo você tendo instalado ele neste momento.

A versão do Ionic instalada em minha máquina para a implementação dos exemplos deste livro foi a mais atualizada no momento da escrita, a 6.18.0. Você pode verificar a versão do Ionic CLI em sua máquina executando a instrução ionic info no terminal. Recomendo que mantenha essa versão durante todo o livro. Caso opte por versões diferentes, mais recentes ou anteriores, podem surgir problemas relativos a especificidades de cada uma.

Com o Ionic e suas dependências devidamente instaladas, precisamos agora do ambiente que utilizaremos para o desenvolvimento de nossas aplicações e adotaremos neste livro o Visual Studio Code, que tem sido adotado amplamente por comunidades de desenvolvedores de diversas linguagens. Ele é gratuito e realmente muito bom. Você pode realizar seu download pelo link https://code.visualstudio.com/. No momento da escrita deste livro, a versão é a 1.63.0.

Após a instalação e execução do aplicativo, é possível verificarmos atualizações do ambiente pelo menu Help -> Check for updates. Em caso de existência de atualizações necessárias, aparecerá o item de menu Install updates. Basta seguir as orientações para que seu ambiente seja atualizado.

Como dito no capítulo anterior, utilizaremos o TypeScript como linguagem, pois é a linguagem adotada pelo Ionic. Também foi comentado que o código TypeScript é convertido (automaticamente) para JavaScript (processo de Transpiling), que é a linguagem que realmente terá o código executado e, certamente utilizaremos os recursos dela, em conjunto com o TypeScript. Desta maneira, é preciso que nosso ambiente (IDE) seja configurado para essas linguagens, o que nos trará benefícios, como autocomplete e intellisense. Sendo assim, na primeira execução do ambiente, aparecerá na janela principal a sugestão de instalação de recursos para essas linguagens. Clique nos links oferecidos para que isso seja realizado. Veja a figura a seguir. A guia apresentada pode ser acessada por meio do menu Help -> Welcome. Já já começaremos a utilizar este ambiente.




[image: Intalando suporte ao TypeScript e JavaScript. ]Figura 2.3: Intalando suporte ao TypeScript e JavaScript.



2.2 Testando a instalação do ambiente com um projeto básico

O Ionic fornece diversos modelos (templates) de projetos que podemos utilizar durante o processo de criação e você pode obter uma lista completa deles executando a instrução a seguir no terminal. Observe que são exibidas opções não só para o Angular.

ionic start --list


Caso você receba uma mensagem de erro relacionada aos direitos de acesso, será preciso você acessar o PowerShell como administrador e então executar a instrução a seguir, que possibilitará a atribuição de poderes ao usuário.

Set-ExecutionPolicy RemoteSigned


Vamos trabalhar a criação de um projeto básico (blank), mas recomendo que você teste a criação de projetos para todos os templates disponíveis, pois isso poderá trazer a você uma visão de alguns recursos que poderão ser utilizados em suas aplicações. Durante o desenvolvimento de exemplos do livro, criaremos as funcionalidades oferecidas por alguns deles.

Para a criação do projeto, recomendo que criemos uma pasta/diretório na raiz de seu disco e que executemos nela, estando no terminal, a instrução a seguir. Este processo pode demorar um pouco, pois depende de sua conexão com a internet, uma vez que o Ionic CLI realizará o download do template desejado. Veja na instrução que capitulo02 é o nome do projeto, blank é o template que será utilizado, type define o angular como engine de templates e, no início, start define que o projeto deve ser criado. A execução dessa instrução poderá demorar um pouco. Como a partir da versão 5, o Ionic tem como padrão o Capacitor, será com base nele que o projeto será criado. Caso queira usar o Cordova, complemente a instrução a seguir com --cordova e, se quiser explicitar o Capacitor, complemente com --capacitor.

ionic start capitulo02 blank --type=angular


Logo no começo da execução do processo disparado pela instrução anterior, caso tenha escolhido o Cordova, uma orientação sobre a recomendação ao Capacitor, ao invés do Cordova, é exibida. Não se preocupe com avisos que possam surgir durante a execução da instrução anterior.

Uma mensagem de criação da pasta para o projeto será exibida. Caso você já tenha a pasta, será perguntado se deseja sobrescrever a que existe. Caso responda negativamente, a criação do projeto é interrompida. Durante a criação do projeto, algumas mensagens, orientações e sugestões serão exibidas. Ao final, uma pergunta sobre a instalação do Ionic Pro SDK é realizada. Responderemos com N neste momento. Observe que durante a instalação é informado que um repositório local do Git é criado. Poderíamos ter utilizado, na instrução de criação do projeto, o flag --no-git para que isso não ocorresse. 

Você notou, na instrução para a criação do projeto, a definição do tipo como Angular (--type=angular)? Pois bem, como dito no capítulo anterior, o Ionic tem uma forte dependência com o Angular, mas agora as aplicações poderão fazer uso do Vue e React. Mas o que são esses artefatos?

Bem, vamos falar do Angular. Segundo seu próprio site (https://angular.io/), ele é uma plataforma que auxilia no desenvolvimento de aplicações web com foco nas Simple Page Applications, que são portais que possuem uma única URL e toda a informação dinâmica dela é configurada por meio de CSS e JavaScript. É uma ferramenta muito boa, poderosa, com muitos recursos e que vale a pena um estudo, principalmente, em nosso caso, pelo fato do Ionic fazer uso destes recursos. Neste livro, nosso foco é o Ionic, mas sempre que formos utilizar recursos vindos do Angular, manifestarei essa situação.

Pode ser que seja perguntado à você sobre criar ou não uma conta Ionic. É gratuita, mas fica a seu critério.

Para obtermos informações em relação ao Ionic, em sua pasta do projeto criada anteriormente, no terminal, digite a instrução a seguir. É a mesma que comentamos anteriormente.

ionic info


Você terá acesso a diversas informações sobre o ambiente e recursos utilizados no projeto Ionic. Em meu caso, em relação a versão apresentada para o Ionic/Angular foi a 5.9.2 e é para ela que implementaremos todo código aqui no livro. Não se preocupe com avisos que possam aparecer referente à pacotes Android e iOS. Logo resolveremos isso.

Em relação à execução do aplicativo Ionic em plataformas diferentes, tem-se o Ionic Native, que é uma biblioteca de plugins que possibilita de maneira simplificada a adição de funcionalidades nativas à plataforma em execução de aplicações móveis e, por isso, é bom termos a versão atualizada em nossos projetos. 

Caso você queira fazer um backup da sua aplicação, você pode retirar a pasta node_modules, criada dentro de capitulo02, pois ela é imensa e pode ser gerada automaticamente por meio do NPM. Quer testar? Crie uma pasta chamada teste, no mesmo nível de capitulo02 e copie para ela todo o conteúdo de capitulo02, com exceção da node_modules. Acesse a nova pasta pelo terminal e execute a seguinte instrução e, ao término, verifique que a pasta node_modules foi criada. Se quiser, pode apagar a pasta node_modules do capitulo02 e executar a mesma instrução para instalar as dependências. Saiba que se utilizar o Git, esta pasta é totalmente ignorada.

npm install


Mas o que é o conteúdo da pasta node_modules? Ainda, o que são as dependências de que estamos falando de maneira constante neste início de livro? Você certamente notou que, para utilizarmos o Ionic, tivemos que instalar alguns recursos e que, ao criarmos um projeto, muitos recursos específicos para um projeto Ionic foram baixados e disponibilizados na pasta node_modules. Estes recursos são vistos como dependências, sem as quais sua aplicação não pode ser desenvolvida e executada. Reforçando, de maneira mais direta, aplicações Ionic dependem muito de outras ferramentas, que podem ser aplicações, componentes e plugins. Veremos e trabalharemos essas dependências durante toda a leitura do livro.

Agora que já temos nosso projeto criado, vamos testá-lo? Acesse a pasta do projeto, que, seguindo nosso exemplo, deve se chamar capitulo02. Você pode acessá-la digitando cd .\capitulo02\ no Windows PowerShell. Estando na pasta, digite a instrução a seguir.

ionic serve


Você poderá notar a exibição de algumas informações ao executar a instrução anterior. As informações iniciais se referem a como acessar a aplicação. Note que a primeira instrução executada é uma chamada ao Angular CLI, conhecido como NG. Na sequência, uma instância de seu navegador padrão será aberta, apresentando a aplicação, tal como é mostrado na figura a seguir. Para registro, eu tenho utilizado o Chrome como navegador padrão, por ser, de acordo com a comunidade, o navegador que está sempre atualizado com as tecnologias web.




[image: Execução básica da aplicação. ]Figura 2.4: Execução básica da aplicação.



Olhando para a figura anterior, ou para seu navegador, você pode se perguntar, mas é assim que a aplicação executará em meu dispositivo móvel? Vamos por partes. Lembre-se de que as aplicações Ionic são Webview, ou seja, são executadas em um ambiente de um navegador web. Então, até o momento, está tudo certo com a execução da aplicação.

Retorne ao terminal e veja que várias instruções apareceram nele. São todas informações de LOG geradas pela preparação e execução da aplicação. Mas vamos verificar agora a execução da aplicação nos pseudoemuladores, que comentei no capítulo anterior. No terminal, pressione CTRL-C para interromper a execução. Após isso, no prompt, digite a instrução a seguir. Na primeira vez que executei, travou, precisei interromper (CTRL-C) e executar novamente.

ionic serve --lab


O flag --lab indicará ao Ionic que a execução da aplicação, embora em um navegador, deve ser apresentada em um ambiente de dispositivo móvel. Ao executar, ainda é possível que o Ionic retorne a você a informação de que não tem, nas dependências do projeto, o pacote @ionic/lab e se ofereça para instalá-lo. Vamos confirmar com Y caso isso ocorra. Após todo o processo de execução e instalação do pacote, o navegador é novamente aberto, agora exibindo a aplicação nos pseudoemuladores.

Permita-me apresentar um erro que pode acontecer com você quando for executar a instrução que habilita os pseudoemuladores. Em um determinado momento, quando executava a instrução anterior, nada aparecia no navegador. Parti para a inspeção de código do Chrome pressionando F12 ou clicando com o botão direito do mouse em qualquer lugar da página e escolhendo a opção Inspecionar. A janela do navegador se divide e, no lado direito, é exibida uma poderosa ferramenta para depuração. Cliquei na guia Console e vi um erro com a descrição Failed to load resource the server responded with a status of 404 (not found). Interrompi a execução do Ionic CLI e, na pasta do projeto, digitei npm install para forçar o download das dependências dos módulos node. Lembra que falei dessa instrução um pouco antes no texto? Após a instalação, executei novamente a instrução ionic serve --lab e tudo voltou a funcionar. Em outro caso, onde essa estratégia não funcionou, eu forcei a carga da página no navegador com CTRL+F5 e tudo funcionou. Veja que essa segunda é mais simples e deve ser a primeira a ser tentada.

Após esse comentário, vamos ao navegador aberto. Veja a figura a seguir. Talvez apareça para você o pseudoemulador do Windows, mas eu preferi tirá-lo por meio do link Platforms. Essa opção se deu pela dificuldade de encontrar dispositivos Windows para testes físicos. Recomendo que deixe sempre apenas um pseudoemulador ativo, é mais rápido. Habilite mais de um apenas quando precisar ver a interface que o usuário visualizará.




[image: Execução da aplicação nos pseudoemuladores. ]Figura 2.5: Execução da aplicação nos pseudoemuladores.



2.3 Execução de forma nativa no iOS

Lembra-se de que comentamos sobre aplicações Ionic poderem ser híbridas? Isso é possível por meio do uso de frameworks que permitem a comunicação de nossa aplicação com o SDK Nativo. Essas aplicações são chamadas de Native Bridge. Vamos então testar a execução em emuladores e dispositivos reais? Vamos começar com o iOS, que tem a necessidade de termos nosso projeto sendo desenvolvido em um equipamento Mac. Mesmo que você não vá testar sua aplicação em um Mac, peço que leia toda esta seção, por ter procedimentos que serão importantes também para Android.

Como dito, o Ionic se integra a duas plataformas que possibilitam o acesso nativo, são elas o Capacitor (https://capacitor.ionicframework.com/) e o Cordova (https://cordova.apache.org/). Até a versão 4 do Ionic, o Cordova era o padrão, tendo o Capacitor como opção. A partir da versão 5, a recomendação do Ionic é o Capacitor, tendo o Cordova como opção, mas focaremos o livro no Capacitor. 

Precisamos realizar algumas configurações para a execução do projeto. Vamos então abri-lo no Visual Studio Code. É importante saber que o ambiente de trabalho de um projeto neste IDE é a pasta onde o projeto está. Desta maneira, precisamos abrir essa pasta no VSC. Se você está com a guia Welcome aberta, clique no atalho Open Folder ou, se preferir, acesse o menu File -> Open Folder e localize a pasta para abri-la. Veja a figura a seguir, que apresenta o ambiente com a pasta aberta.




[image: Visual Studio Code com a pasta do projeto aberta. ]Figura 2.6: Visual Studio Code com a pasta do projeto aberta.



Com a pasta aberta, selecione o arquivo capacitor.config.json na raiz do projeto para que o VSC o abra em seu editor de código. Precisamos  alterar o atributo appId e appName. O valor que devemos ter neste no appId deve respeitar uma notação chamada Reverse domain name notation, que traz o domínio da aplicação iniciando pelo fim. Por exemplo, teremos nosso domínio chamado casadocodigoionic.com.br. Assim, nosso appId será br.com.casadocodigoionic e em appName eu utilizei Capitulo 02 apenas para ilustrar.

Se por algum acaso acontecer de o arquivo capacitor.config.json ser apagado, para que ele seja novamente criado, você precisa executar npx cap init para sua recriação. 

Para que possamos executar nossa aplicação iOS no Mac, precisamos do XCode instalado, pois é a ferramenta oficial da Apple para desenvolvimento. Se você não tiver o aplicativo em seu Mac, precisará instalá-lo pela App Store. No momento da escrita deste livro, ele estava na versão 13.1 (13A1030d).

A preparação de nosso ambiente para o uso do Capacitor, no Mac, demanda um conjunto de pré-requisitos e dependências. A primeira delas se refere à instalação da dependência CocoaPods, que é um gerenciador de dependências para projetos Swift e Cocoa Objective-C. Não entrarei em detalhes sobre isso por não fazer parte do escopo do livro. Sendo assim, no terminal de seu Mac, digite as instruções a seguir.

// Instalação do Cocoapods. A versão neste momento é a 1.10.2
sudo gem install cocoapods

// Instalação Xcode Command Line tools, se necessário
xcode-select --install

// Atualização do repositório local do CocoaPods
pod repo update


Para que você se torne um desenvolvedor certificado pela Apple e possa fazer parte do Apple Developer Program, existe uma série de tramitações que devem ser seguidas e que estão muito bem documentadas no portal da Apple. Entretanto, para fazer um deploy como um desenvolvedor "simples" e sem custo, existe um processo mais simples de ser realizado, e é ele que veremos aqui. 

O primeiro requisito é ter um Id Apple. Se não tem, obtenha um em https://appleid.apple.com/account#!&page=create/. Em seguida, em seu Mac, acesse o XCode e acesse o XCode Menu -> Preferences. Na categoria Accounts, clique na base esquerda, no botão + para adicionar seu Id Apple. Sua senha será solicitada neste momento e a janela a seguir é exibida.




[image: Criando uma conta no XCode. ]Figura 2.7: Criando uma conta no XCode.



Com a conta criada, precisaremos criar uma Signing Identity. Clique no botão Manage Certificates... e a próxima janela é exibida. Clique no botão Create e selecione iOS Development. Após estes passos, você pode, se quiser, fechar o XCode.




[image: Criando uma Signing Identity. ]Figura 2.8: Criando uma Signing Identity.



Após termos a configuração e ferramentas necessárias disponíveis em nosso equipamento, precisamos dar sequência em instruções para preparar nosso projeto e abri-lo no XCode. Veja na sequência.

// Adição da plataforma iOS ao projeto
ionic capacitor add ios

// Construção e abertura do projeto iOS no XCode
ionic capacitor build ios


Você pode optar por abrir o projeto já com o XCode aberto. O que devemos fazer é abrir a pasta platforms/ios, que temos dentro de nossa pasta capitulo02. Esta pasta foi gerada quando adicionamos o iOS ao projeto. 

Com o projeto aberto, selecione o nó principal (App) e, na guia que se abre, verifique se os campos Display Name e Bundle Identifier, na categoria Identity, estão como configuramos no VSC. Se não estiverem, ajuste.

Em seguida, na categoria Signing & Capabilities, marque o checkbox Automatically manage signing e selecione o Team, que você criou. Para finalizar esta etapa, na categoria Deployment info (na guia General, selecione a versão alvo para sua aplicação. Em meu caso, selecionei a mais recente, que era a 15.0. Com essa seleção, estamos dizendo que os dispositivos que poderão executar nossa aplicação deverão estar atualizados, no mínimo, com o iOS 15.0. Se você quiser que versões anteriores possam executar seu aplicativo, basta selecioná-las. Lembre-se de que quanto menor a versão alvo, menos recursos atuais da plataforma estarão disponíveis e quanto mais recente a versão, menos dispositivos desatualizados poderão executá-la.

Com as configurações realizadas, você pode executar sua aplicação. No topo da janela do XCode, existe um botão de play e, ao lado dele, o nome da aplicação seguido pelo dispositivo onde sua aplicação executará. Essa localização pode ser diferente dependendo da versão do XCode que utiliza, mas, se clicar diretamente no play, um simulador será aberto. Na listagem de dispositivos, a princípio, são exibidos simuladores, mas se você tiver um dispositivo conectado ao Mac, ele também aparecerá na listagem. Para começarmos, escolha um simulador e execute. O processo de deploy (implantação) ocorrerá, e a aplicação executará.

Vamos ao dispositivo físico agora? Conecte-o ao Mac, selecione-o na lista de dispositivos no XCode e execute a aplicação. Se neste momento uma janela de erro aparecer em seu dispositivo, informando-o para verificar configurações de confiança, não se preocupe, isso ocorre na primeira execução de uma aplicação via o mecanismo que estamos utilizando, o de depuração. Realize a configuração indicada pelo dispositivo, que é bem simples, e execute novamente sua aplicação. Em meu iPhone, eu acessei Ajustes->Geral->Gerenciamento de Dispositivo->Selecionei meu ID Apple->Confirmar confiança. Se tudo deu certo, a aplicação será executada em seu dispositivo. Lembre-se de encerrar a execução da aplicação no XCode ou no próprio dispositivo.

Se formos realizar alguma alteração no projeto, as atualizações não são aplicadas diretamente na aplicação que executamos no emulador/dispositivo. Precisamos executar novamente a instrução ionic capacitor build ios e voltar ao XCode e executar novamente a aplicação. Não é preciso fechar o XCode e nem o projeto nele para isso. Logo veremos a execução da aplicação diretamente pelo terminal.

E se realizarmos alterações em nosso projeto Ionic? Precisamos novamente realizar o processo de construção que executamos anteriromente?

A boa notícia é que o Capacitor traz também a funcionalidade de Live Reload. Isso nos permite executar a aplicação no dispositivo, realizarmos alterações em nosso projeto e vermos essas atualizações serem realizadas no aplicativo em execução, sem ter que utilizar o XCode. 

A execução com o Capacitor com Live Reload é simples. Veja o código a seguir, que exibirá uma lista de dispositivos e emuladores disponíveis para a execução, ficando para você a responsabilidade dessa escolha. Caso na execução das instruções a seguir, você receba um erro ERR_CONNECTION_REFUSED, insira, ao final da instrução o argumento --external. É uma recomendação do próprio Ionic.

ionic capacitor run ios -l


Caso você queira maior agilidade, dizendo já na instrução em qual dispositivo você deseja executar seu aplicativo, podem ser utilizadas as instruções a seguir.

// Para obter uma relação dos emuladores e dispositivos disponíveis
ionic capacitor run ios --list

// Para executar em um específico dispositivo
ionic capacitor run ios -l --target="<TARGET ID DO DISPOSITIVO>"


Com a aplicação em execução, modifique alguma coisa no home.page.html (pelo Visual Studio Code), grave e observe seu dispositivo. A alteração apareceu? Legal, não é? 

Diversas outras opções são disponibilizadas pelo Capacitor. Caso se interesse, recomendo a verificação dessas opções na documentação oficial disponibilizada em https://ionicframework.com/docs/cli/commands/capacitor-run.

2.4 Execução de forma nativa no Android

O procedimento para utilização do Capacitor para o Android é semelhante ao que vimos para iOS. Precisamos da mesma configuração no capacitor.config.json e da execução das instruções a seguir para termos o projeto agora sendo aberto no Android Studio. Caso lhe seja perguntado sobre atualizações no projeto Android, responda sempre com não.

// Adição da plataforma iOS ao projeto
ionic capacitor add android

// Construção e abertura do projeto iOS no XCode
ionic capacitor build android


Vamos executar agora a aplicação Android diretamente do terminal, proporcionando o Live Reload para as alterações realizadas no código Ionic. Essa execução é igual ao que fizemos para o iOS, mudando apenas a plataforma. Veja a instrução a seguir.

ionic capacitor run android -l


Caso você queira maior agilidade, dizendo já na instrução em qual dispositivo você deseja executar seu aplicativo, podem ser utilizadas as instruções a seguir.

// Para obter uma relação dos emuladores e dispositivos disponíveis
ionic capacitor run android --list

// Para executar em um dispositivo específico
ionic capacitor run android -l --target="<TARGET ID DO DISPOSITIVO>" --host=0.0.0.0


Com a aplicação em execução, modifique alguma coisa no home.page.html (pelo Visual Studio Code), grave e observe seu dispositivo. A alteração apareceu? Legal, não é? 

Diversas outras opções são disponibilizadas pelo Capacitor. Caso se interesse, recomendo a verificação dessas opções na documentação oficial disponibilizada em https://ionicframework.com/docs/cli/commands/capacitor-run.

Para executarmos a aplicação em um dispositivo Android, precisamos habilitar as opções para o desenvolvedor (Developer Options). Para isso, no dispositivo, vá em Configurações -> Sobre o dispositivo -> Informações de Software e clique sete vezes sobre o Número de compilação (build number). Após isso, retorne para Configurações e clique em Opções do Desenvolvedor (Developer Options) e habilite a opção USB Debugging. Se essas opções não aparecerem para seu dispositivo, você precisará buscar na documentação dele como acessá-las. Normalmente, nos sites de pesquisa, ao digitar as palavras-chaves android ativar modo desenvolvedor <fabricante-e-modelo-dispositivo>, as orientações necessárias já são trazidas.

Com seu dispositivo liberado para testes e devidamente conectado ao seu computador, feche o emulador e, no Android Studio, selecione seu dispositivo na lista disponibilizada ao lado do play e execute sua aplicação. Bem mais simples que no iOS, certo?

2.5 Depuração

Depurar uma aplicação é tão importante quanto a criação de código. Entretanto, depurar um código TypeScript, ou JavaScript, em tempo de execução não é algo trivial pela característica das tecnologias empregadas. Temos uma ferramenta poderosa no console do navegador. Mas e quando utilizamos um dispositivo? Também fazemos uso do console, que, no caso do Chrome, é de fácil acesso, mas também há disponibilidade dele para o Safari.

Para termos o console do dispositivo acessível, utilizando o navegador Chrome, precisamos informar a URL chrome://inspect/#devices/. Os dispositivos físicos conectados a seu equipamento ou via rede aparecerão na página aberta, assim como a aplicação em execução no emulador. Precisamos então clicar no link Inspect, que aparece, e nossa janela de console se tornará disponível. Isso ajuda e muito, por isso, guarde bem essa informação.

Conclusão

Chegamos ao final deste segundo capítulo. Conseguimos identificar as ferramentas que utilizaremos, realizamos as instalações delas e as testamos em um projeto simples. Foi possível também executarmos a aplicação desenvolvida em dispositivos físicos e emuladores específicos do iOS e Android, por meio do Capacitor, o que nos viabiliza o uso nativo de recursos dos aparelhos. Pudemos verificar que existe sempre a possibilidade de ocorrência de alguns erros/problemas, mas todos são contornáveis. Muita coisa interessante foi vista, e estamos apenas no segundo capítulo. Vamos pegar um fôlego antes de começarmos o terceiro?
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